Skyline Custom Reports and Results Grid

The Skyline Targeted Proteomics Environment provides informative visual displays of the raw mass
spectrometer data you import into your Skyline documents. It allows you to work with this data, to
refine the peptides and transitions you are measuring and to tune integration boundaries. A rich variety
of calculated values and statistics may be exported from your Skyline document to a tabular comma
separated value (CSV) file perfect for further analysis in tools like Excel and R. The Skyline Results Grid
displays many of these values and allows you to edit custom annotations as you work with your data.

The first part of this tutorial will focus on Skyline custom reports. You will learn how they can be
designed, shared and used to export raw values and summary statistics from your Skyline documents.
Exported reports can be used in the following ways:

e Deeper statistical analysis in tools like Excel or R

Broader statistical analysis across multiple experiments and/or laboratories

Enforcing instrument quality control with summary statistics

Providing an input format for other custom build software tools

Providing an import format suited to relational data repositories

In developing Skyline we aim to create a vendor-neutral platform for targeted proteomics investigation.
Skyline can export similar custom reports for documents populated with the data from Agilent, AB Sciex,
Thermo-Scientific and Waters instruments. The ability to create consistent reports across instrument
platforms greatly facilitates cross-instrument comparisons and large multi-site studies.

Understanding how to create custom reports, tailored to your own experiments, is critical and described
in detail in this Skyline custom reports tutorial.

The second part of this tutorial will focus on the Results Grid view in Skyline, which provides real-time
access to many of the data fields available in the custom reports. You will learn to customize columns in
the Results Grid for immediate access to important values, as you inspect and refine your mass
spectrometer output in Skyline. You will also learn to work with custom annotations to provide a
controlled vocabulary for further interpretation of and human interaction with your results, which can
also be exported in custom reports.

Getting Started

To start this tutorial, download the following ZIP file:

https://skyline.gs.washington.edu/tutorials/CustomReports.zip




Extract the files in it to a folder on your computer, like:
C:\Users\brendanx\Documents

This will create a new folder:
C:\Users\brendanx\Documents\CustomReports

Now open the Study7_example.sky file in this new folder by double-clicking, or by using Open on the
File menu in a running instance of Skyline.

Data Overview

The dataset in Study7_example.sky is a subset of a study that was performed by the Clinical Proteomics
Technology Assessment for Cancer (CPTAC) consortium (T. Addona et al “Multi-site assessment of the
precision and reproducibility of multiple reaction monitoring—based measurements of proteins in
plasma”, Nature Biotechnology, 2009, 27, 633 - 641). This particular study describes a calibration curve
at different concentrations of analyte peptides and a constant spike in level of their corresponding
isotope labeled internal standards.

The Skyline file displays data from a subset of CPTAC Study 7.2 data (in the paper referred to as “Study
II”) acquired at one CPTAC site. The Skyline file shows data for 10 different peptide sequences
monitored by LC-MRM-MS with concentrations for the analyte proteins (see light peptides) ranging from
concentrations at 500 fmol to 2.92 fmol (replicates J: 500 fmol; I: 275 fmol; H: 151 fmol; G: 83 fmol; F: 46
fmol; E: 25 fmol; and D: 8.55 fmol — lower concentration points although acquired are not included in
this tutorial). Heavy internal standard (IS) peptides are each spiked in at a concentration of 50 fmol.

To get a first impression what this dataset looks like perform the following steps:

e C(lick on the ‘HGFLPR’ peptide to highlight it.
e On the View menu, choose Peak Areas, and then click Replicate Comparisons.

A new window appears that shows peak area for each replicate. The blue bars represent the heavy
labeled version of this peptide (always spiked in at 50 fmol), and the red bars represent the light analyte
at varying concentrations (each concentration point was acquired in technical quadruplicate).

Other tutorials describe how you can view and edit documents like this one. For the purposes of this
tutorial, however, the Study7_example.sky document has received an initial integration review, fully
preparing if for reports to be exported and used in deeper statistical analysis. Before continuing with
the rest of the tutorial:

e C(Close the Peak Areas view.



Creating a Simple Custom Report
To create your first Skyline custom report template, perform the following steps:

e On the File menu, choose Export, and click Report

An Export Report form will appear that will probably list at least the Skyline default report templates
shown below:
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Continue creating a new Skyline custom report template by performing the following steps:

e C(lick the Edit list button.
e In the Edit Reports form, click the Add button.
e In Edit Report form, enter ‘Overview’ in the Report Name field.

The form should now look like:
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e Expand the field groups Peptides and Results by clicking on the ‘+’ button to see many more
fields that can be exported. See Window below.

e From the expanded Peptides group select the Sequence field.

e C(Click the Add button to add the PeptideSequence field to the report template column list,
shown on the right side of the form.

The form should now look like:
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Note that the fields in the Edit Report form, shown above, have a distinct hierarchical structure. At the
highest level are the protein specific export fields which are shown at the bottom of the left box
(ProteinName, ProteinDescription, ProteinSequence, ProteinNote, and the expanded Results group
above these that contains the general fields ReplicateName, ReplicatePath, FileName and
SampleName). Skyline custom reports also provide peptide specific export fields, contained in the
expanded Peptides group at the top of the left box, such as Sequence and
AverageMeasuredRetentionTime among others. The peptide fields include a PeptideResults group,
which is not expanded yet. Also unexpanded is the Precursors group, which contains precursor specific
export fields, a PrecursorsResults group, and finally a Transitions field group. The Transitions group, in
turn, contains the transition specific export fields and a corresponding TransitionResults group,
containing the most detailed results values, such as Retention Time, Fwhm, StartTime, EndTime, Area
and Background, from which many of the higher level results field values are derived .

In the Edit Report form continue to add fields to your first custom report template by performing the
following steps:

e Expand the Precursors group (located directly below the expanded Peptides group at the very
top) by clicking on the '+ icon.
e Expand the PrecursorResults group field now visible in the expanded Precursor group.



e Select IsotopeLabelType field (marked below with a red dot) from the expanded Precursors
group. (If necessary, scroll down or resize the form.)
e C(Click the Add button to add IsotopeLabelType to the report template column list.
e Repeat this procedure to add the following additional fields from the PrecursorResults group to
the report template column list:
0 BestRetentionTime - the RetentionTime value of the transition with the highest
maximum intensity for the particular precursor
O TotalArea - the summed Area values of all individual transitions for the particular
precursor (for more information on field values, see Glossary)
e Check the Pivot Replicate Name check box in the lower left corner of the Edit Report form.

This should leave the Edit Report form looking like:
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e C(lick the Preview button in the upper right corner of the Edit Report form.

The Preview Report form should appear looking like:
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19.09 1022147 19.09
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The Preview function is quite helpful when designing report templates. At times it may even serve as a

quick substitute for exporting a report to a file, since you can select all of the values in the Preview

Report form by clicking the upper-left rectangle. Pressing Ctrl-C, then copies the full report. After

which, it can be pasted into another tool, like Excel.

The report preview displayed in part above, for replicates 7_2_D_01, and 7_2_D_02, shows precursor

BestRetentionTime and TotalArea for all 10 peptides in both their light and heavy form across all LC-

MRM-MS acquisitions/experiments in the columns to the right. By scrolling to the right, you can see

columns for all 28 LC-MRM-MS acquisitions. Maximize the Preview Report form by clicking on the

square in its upper right corner to see more columns. In thisexample7 2 D _01,and7_2 D_02 are

taken from samples at the same light analyte concentration. Therefore, TotalArea values are expected

to be similar. Each letter D through J indicates a different light analyte concentration. Each

concentration was acquired in technical quadruplicate, indicated by numbers 01 through 04. The heavy

peptide concentrations were held constant at 50 fmol in all samples.

Close the Preview Report form by clicking on the ‘X’ in the upper right corner to return to the Edit

Report form again. To save this report template:

Click the OK button.



You will see the new Overview report template appear in the Report template list.
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e C(lick the OK button again to return to the Export Report form.

The new Overview report template is now added to the Skyline report template list. The Export Report
form should now look like:
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From the Export Report form you can now export your new report by selecting ‘Overview’ in the Report
list and clicking the Export button. For now, click the Cancel button, dismissing all open forms, in order
to start the process from the original Skyline document view.

Exporting Report Data to a File

To export the report you created and previewed above to a CSV file, do the following:
On the File menu, choose Export, and click Report.

e Select’Overview’ in the Report list of the Export Report.

e C(lick the Export button.

e Enter ‘Overview_Study7 example.csv’ in the File name field of the Export Report save form.
e C(lick the Save button.

If you switch to a Windows Explorer window, showing the CustomReports folder you created for this
tutorial, you will see the Overview_Study7_example.csv file you just created. Open it now with Excel
and confirm that its contents are quite similar to the preview you displayed earlier. Note that the file
contains the column header names, which you cannot get by simply copying and pasting from the

preview form.

Sharing Report Templates

Report Templates in Skyline are very flexible, easy to manage and modify, and share with collaborators.

There are many reasons you might want to share a custom report template, whether you are
participating in a large multi-laboratory study or working with a single collaborator, whether your are
providing the proteomics community with your own custom tool that depends on particular fields from
Skyline documents or providing supplementary information with a manuscript to allow others to repeat
your protocols. The Skyline support for instruments from multiple vendors means your shared report
templates can be used to gather data from multiple sites with different instrumentation.

To share the Skyline report template you created in this tutorial, perform the following steps:

e On the File menu, choose Export, and click Report.
e C(Click the Share button in the Export Report form.

Skyline will present the Save Report Definitions form, as shown below:



Save Report Definitions ﬁ

Select the report definitions you want to save to a file.

|| Peptide Ratio Results
(] Overview

"] Peptide RT Resutts

| Transition Results

Select / deselect all

e Check ‘Overview’ in the report definitions list.

e C(lick the OK button.

e Enter ‘Overview’ in the File name field of the Save As form.
e Click the Save button.

The report template is saved to the file Overview.skyr in the CustomReports folder created for this
tutorial. You could now share it with your collaborators, with your own analysis tool or as
supplementary data for a manuscript.

Managing Report Templates in Skyline

To gain an understanding of how others would use the custom report template you have now created
and shared, you need to first delete it from your system. Then you can add it back using the shared
report file Overview.skyr that you created in the previous section, as if you had acquired this shared
template from another source.

The Export Report form should still be open after the steps performed in the previous section. To
delete the ‘Overview’ report template from your Skyline settings, do the following:

o C(lick the Edit List button.
e Select the ‘Overview’ item in the Report list of the Edit Reports form.

The Edit Reports form should now look like:
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You can use the Up and Down buttons to change the order of the items in the Report list. To move the
‘Overview’ item to the bottom of the list, do the following:

e Click the Down button twice.
e C(Click the Up button three times to move the ‘Overview’ item to the top.

To remove the ‘Overview’ item from the list, do the following:

e Click the Remove button.
e (Click the OK button.

The Export Reports form should now look like:
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Just as when you first brought it up in this tutorial.

To demonstrate how your collaborators would import a new report template into Skyline follow the
steps described below:

e Click the Import button.

e Select the ‘Overview.skyr’ file you created earlier in the Open form (which should still be
showing the contents of the ‘CustomReports’ folder for this tutorial).

e Click the Open button.

These actions should add an ‘Overview’ item back to the Report list in the Export Report form. To verify
that this is indeed the report you saved, perform the following steps:

e Select the ‘Overview’ item in the Report list.
e Click the Preview button.

Skyline will present a Preview Report form containing the same values you saw earlier in this tutorial.

Modifying Existing Report Templates

You can, of course, create much more data rich reports than the simple ‘Overview’ report you first
created in this tutorial. You can do this by creating another new report template, by editing your
existing ‘Overview’ report, or, as shown below, by making a copy of the ‘Overview’ report and editing
the copy. To create a new, more complex report from a copy of the ‘Overview’ report template,
perform the following steps:
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e Click on Edit List button in the Export Report form.
e Select the ‘Overview’ item in the Report list.
e Click on the Copy button.

Skyline will present the Edit Report form with the fields from the ‘Overview’ report template already
added, as shown below:

"4y Edit Report s
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The report name for this new report template has not yet been assigned. To assign it now:
e Enter ’Study 7’ in the Report Name field.

Continue to add more fields as described below by selecting each field and clicking the Add button in
the middle to add each field to the column list for your report template, on the right side of the Edit
Report form:

e Expand the field groups Peptides and Results by clicking the ‘+’ icons to their left.
e From the expanded Results group, add the following fields:
0 FileName — the name of the file from which the data was imported
O SampleName - the sample name, if the data was imported from a multi-sample WIFF
file, or the file name again, if not
0 ReplicateName — the replicate name assigned to the data during import
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e From the top level add ProteinName.
e From the expanded Peptide group, add the AverageMeasuredRetentionTime field — the
average retention time over all replicates.
e Expand the PeptideResults group.
e From the expanded PeptideResults group, add the following fields:
0 PeptideRetentionTime — peptide RT for each replicate run
O RatioToStandard — area ratio of light to heavy
e Expand the Precursors group.
e From the expanded Precursors group, add the following fields:
0 Charge (displayed in the column list as PrecursorCharge)
0 Mz (displayed in the column list as PrecursorMz )
e Expand the Transitions group.
e From the expanded Transitions group, add the following fields:
0 ProductCharge
0 ProductMz
0 Fragmentlon —the fragment ion name (e.g. y8, y10, b7, etc.)
e Expand the PrecursorResults group.
e From the expanded PrecursorResults group, add the following fields:
0 MaxFhwm - the maximum full width at half max (FWHM) of the transitions for the
particular precursor
0 MinStartTime - elution time start at the baseline of a peak, which will be the same for
all transitions (Q1/Q3) from the same precursor
0 MaxEndTime - elution time start at the baseline of a peak, which will be the same for all
transitions (Q1/Q3) from the same precursor
e Expand the TransitionResults group.
e From the expanded TransitionResults group, add the following fields:
0 RetentionTime — retention time at the maximum intensity for a transition peak
Fwhm — full width at half max for the transition peak
StartTime — retention time at the starting transition peak integration boundary
EndTime — retention time at the ending transition peak integration boundary
Area — area under the curve (AUC), minus background, for the transition peak
Height — maximum intensity for the transition peak
UserSetPeak - indicates whether or not (TRUE/FALSE) integration borders for a
transition were manually adjusted

O O O 0O oo

e Also, uncheck the Pivot Replicate Name checkbox, at the bottom of the form.

The report template should now contain a lot more detail than the original ‘Overview’ report templat,
and the Edit Report form should look like:
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To reorder some fields in this new report template, do the following:

o Select ProteinName in the column list on the right.

e C(Click the up arrow on the far right until the ProteinName field is at the top of the list.

You can achieve whatever ordering suits you best, in this way, using the up and down arrow buttons on

the far right, and you can remove fields you may have added by mistake with the red ‘X’ button above
the arrow buttons. This tutorial, however, will continue without making any further changes to the

column list.

To preview the values for the current document in the report template you have created, do the

following:

e Click on the Preview button.
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e When you have reviewed the data, close the preview form.

With data like this, where each peptide has both a light analyte and a matching heavy isotope labeled
internal standard, it may be more convenient to work with the data for these paired precursors all in a
single row to allow you to compare matching transition values more easily.

To make this change to the ‘Study 7’ report template, do the following:

e Check the Pivot Isotope Label check box.
e Click on the Preview button again to see how the report preview has changed.

All of the values for matching light and heavy transitions have been added to the same row. New
columns have been added to achieve this, and columns specific to an isotope label type have been given
the prefixes ‘light’ and ‘heavy’.

The Preview Report form is shown below, scrolled to show the transition between ‘light’ and ‘heavy’
column names:

( 1y Preview Report [ESEE] ™)
‘ light Height light heavy heavy ) heavy heavy heavy -
‘ UserSetPeak IsotopelabelType BestRetentionTime TotalArea PrecursorMz | ProductMz
Iy |27 Faise heavy 19.32 763783 74734814 1092515714
‘ 1838 | Fatse [heavy 19.37 | 770870 74734814 11092515714
2347 | False heavy 119.35 754471 747.34814 11092515714

‘ 2000 | False Iheavy 19.31 767662 747.34814 11092515714
} 4720 False heavy 19.37 670318 74734814 1092515714
| 4220 False heavy 19.42 672388 74734814 1092515714
\ 5231 False heavy 19.41 735818 747.34814 1092.515714
} 5034 False heavy 194 679216 74734814 1092515714
| 7584 False heavy 19.44 612645 74734814 1092515714
‘ 8172 False heavy 19.45 737687 74724814 1092515714
| 7422 Feles heavy 194 715710 74724814 1032515714

8068 False heavy 19.44 677488 747.34814 1092515714

11888 False [heavy 19.45 611335 74734814 11092515714

11290 False [heavy 1952 | 655921 74734814 11092515714

13564 | False heavy 19.57 612164 747.34814 11092515714

11949 | Falee heavy 119,52 602578 74734814 11092515714

19743 | False Iheavy 1957 | 596042 |747.34814 11092515714

22445 | False Iheavy 19.49 | 595138 |747.34814 11092515714
| 21525 False heavy 1952 626408 747.34814 1092515714
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You might notice that the column ‘heavy IsotopelabelType’ shows ‘heavy’ on every row, and that there
is also a column ‘light IsotopelLabelType’ which shows ‘light’ on every column. When you are pivoting on
a column, it does not add much to include it in your column list. Close the Preview Report form, and do
the following to remove the ‘IsotopelabelType’ field from this report:
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e Select ‘IsotopelabelType’ in the column list on the right.
e C(lick the red ‘X’ button on the far right edge of the column list.

You can click the Preview button again to verify that both the ‘light IsotopelabelType’ and the ‘heavy
IsotopelabelType’ columns have been removed. The next step in this tutorial, however, is to save your
work by doing the following:

e C(lick the OK button in the Edit Report form.
e C(Click the OK button in the Edit Reports form.

This will return you to the Export Report form, which should now look like:

f Export Report %
Report:
Fero R Rt
Transition Results

| oot | [ Conce

From here, you could now continue to export the new ‘Study 7’ report to a CSV file by selecting it and
clicking the Export button, or click Share button to create file for sharing this new report. For this
tutorial, however, click the Cancel button to return to the ‘Study7_example’ document.

Quality Control Summary Reports

So far you have created reports based on the values Skyline offers for each imported replicate of the
peptides and transitions specified in a document. Skyline also provides report fields with summary
statistics across all imported replicates. These summary fields are particularly suited to quality control
by ensuring that replicate QC runs show good reproducibility and coefficients of variation (CV). Skyline
report templates can be designed with mean values and CV over all replicates for key parameters, such
as peak area, FWHM and retention time.

17



This tutorial provides a summary report template that you will import into Skyline, but it also describes
how to design such a summary report template in the Edit Report form.

To get started, first open a new document by doing the following:

e On the File menu, click Open.

e Navigate to the ‘CustomReports’ folder you created for this tutorial. (may not be necessary)
e Select the ‘Study9pilot.sky’ file.

e C(Click the Open button.

This file contains data acquired by one CPTAC site over 5 LC-MRM-MS runs, injecting 10 analyte peptides
at a constant concentration of 50 fmol over all 5 runs. Such a dataset could potentially be used to assess
reproducibility of replicate injections.

To generate a summary report for key quality control metrics follow the steps below:

e On the File menu, choose Export, and click Report.

e C(Click the Import button in the Export Report form.

e Select the Summary_stats.skyr file from the ‘CustomReports’ folder in the Open form.
e C(Click the Open button.

A new report template named ‘Summary Statistics’ should have been added to the Report list, and the
Export Report form should now look like:

Export Report

Report:

Peptide Ratio Results
Peptide RT Results
Transition Results
Overview

Study 7

Summary Statistics
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To see the report fields included in the ‘Summary Statistics’ report template, do the following:

e C(lick the Edit List Button in the Export Report form.
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e Select ’'Summary Statistics’ in the Report list of the Edit Reports from.

e Click the Edit Button.

Skyline displays the Edit Report form with many mean and CV field names in the report column list on

the right. To see where these fields came from, perform the following steps:

e Expand the field group Peptides by clicking on the ‘+" icon to its left.

e Expand the field group Precursors.

e Expand the field group PrecursorResultsSummary.

The Export Report form should now look like the image below (without the blue dots, which are added

to indicate the fields already added to this report template):

" 4a Edit Report

Report Name: Summary Statistics

[=)- Peptides
(=) Precursors

t}- Transitions

PrecursorResults

PrecursorResults Summary
MinBest Retention Time @
MaxBestRetentionTime @
RangeBestRetentionTime @
MeanBestRetentionTime @
StdevBestRetention Time
CvBestRetentionTime @
MeanMaxFwhm @
StdevMaxFwhm
CvMaxFwhm e
MeanTotalArea @
StdevTotalArea
CvTotalArea @
MeanTotal AreaRatio
Stdev TotalAreaRatio
CvTotalAreaRatio
Mean Total AreaNomalized
Stdev TotalAreaNomalized
CvTotalAreaNomalized

Charge

IsotopeLabel Type

=)
&t

=)
Lt‘

o
1.

- ProteinName
= Peptide Sequence
MeanTotalArea
CvTotalArea
MeanMaxFwhm
CvMaxFwhm
RangeBestRetention Time
MeanBestRetention Time
= CvBestRetentionTime
MinBest Retention Time
MaxBest Retention Time

-

[] Pivot Isotope Label

To preview this report on the data in the current document:

e C(Click the Preview button in the Edit Report form.
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The Preview Report form is shown looking like:

1y Preview Report

ESATERT)

; ProteinName  Peptide Sequence MeanTotalArea
» mAGLCOTFVYGGCR 41711497
LEP INDISHTQSVSAK | 5870247
MYO LFIGHPETLEK | 71014711
MBP HGFLPR 15131783
1 MBP YLASASTMDHAR | 59848554
| PSA IVGGWECEK 49199171
PSA |LSEPAELTDAVK | 64877269
} HRP | SSDLVALSGGHT... | 16337915
\ CRP ESDTSYVSLK 19049916
‘ CRP GYSIFSYATK 68231290
il « m

CvTotalArea

3.9%
4.6%
122.4%,
11.4%
2%
1.3%

2.7%

MeanMaxFwhm CvMaxFwhm

0.26
0.15
0.2

0.25
0.18
0.24
0.25
0.19
0.21
0.29

RangeBestRetertionTime MeanBe:

1.1%

1.3%
411.1%
5.1%
1.3%
1.5%
1.6%
1.7%
2.7%

18.25
13.69
1454
14.49
14.28
15.57
17.34
17.14
15.52
20.68

This report shows that the data in Study9pilot.sky, taken from 5 replicate injections of the same sample,

produce peptide CV values for FWHM mostly below 5% and TotalArea in most cases under 10% as

indicated for the corresponding columns with red boxes. In addition, the column called

RangeBestRetentionTime (red box) lists the RT drift in minutes for any specific peptide over the 5

replicate injections. In this case there is only minimal RT drift (< 0.15 min, < 10 sec).

These summary reports can be used to flag quality control issues early, before they impact data

acquired on important samples. In this particular dataset, HPLC and MS seem to behave acceptably. In
one case, however, for the peptide INDISHTQSVSAK (from protein LEP), the CV value for TotalArea is
59.2% and for FWHM is 23.5% (circled in red), significantly differing from the CV values of all the other
peptides. To return to the Skyline document and inspect this peptide more closely, do the following:

e Close the Preview Report by clicking on the red ‘X’ in the upper right corner.
e Click the Cancel button in the Edit Report form.

e Click the Cancel button in the Edit Reports form.

e C(Click the Cancel button in the Export Report form.
e Select the peptide ‘INDISHTQSVSAK' in the peptide tree view.

e On the View menu, choose Peak Areas, and click Replicate Comparison (F7).
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The Peak Areas view, showing the total peak area and the contribution of each transition for all 5
replicates, help clarify the problem that was indicated in the CV values of the summary report preview.
For comparison, select several of the other peptides. The Peak Areas view will show much better peak
area reproducibility, as indicated by their much lower TotalArea CV values in the summary report
preview, where the majority of the peptides had CV values < 10%.

Skyline summary reports can be used with quality control data to flag issues early, while Skyline itself
provides powerful visual displays to help get to the root of the problem quickly.

Results Grid View

In some cases, you may want to see some of the values presented in reports while you are editing the
data, for immediate access to raw values displayed in the Skyline charts. The Skyline Results Grid view
provides real-time access to many of the data fields available in the custom reports. In the final sections
of this tutorial, you will learn to use the Results Grid to gain immediate access to important values and
to annotate your data to capture important human insights, as you inspect and refine your mass
spectrometer output in Skyline.

To get started using the Result Grid view, do the following:
e On the View menu, click Results Grid (Alt-F2).

Skyline should now look something like this:
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Now rearrange the windows for better viewing, by doing the following:

e C(Click the Results Grid caption and drag it to the bottom edge of the main window to dock it.
e Click the Peak Areas caption and drag it to the right edge of the main window to dock it.

e C(Click and drag the splitters between the various window panes to adjust the space allocation.
e On the View menu, choose Auto-Zoom, and click Best Peak, if it is not already selected.

e Select the precursor element ‘467.2440+++" below the currently selected peptide.

This should leave Skyline looking something like:
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Skyline keeps its charts and the Results Grid in synch as you navigate the data. If you click on one of the
other rows in the Results Grid, Skyline changes the active chromatogram replicate tab. It also changes
which bar in the Peak Areas graph has the selection rectangle around it, as well as the selection in the
Replicates list above the peptide tree view. Now click on a different chromatogram chart tab, bar in the
Peak Areas chart, or change the selection in the Replicates list. The other views will update, including
the selected row in the Results Grid.

The first column to the right of the Replicate Name column in the Results Grid is the Precursor
Replicate Note. This column allows you to associate a free text note with the PrcursorResults field
group for the selected precursor and replicate. Try typing ‘Low signal’ in the first row with replicate
name ‘Repl’ for the currently selected peptide.

All of the other columns in the current Results Grid display are calculated by Skyline and cannot be
edited, but you can change which columns get displayed and in what order. Several of the columns are
scrolled out of view in the image above. To reduce the number of precursor results columns being
displayed, do the following:

e Right-click on the column headings, and click Choose Columns.
e Uncheck the columns Min Start Time, Max End Time and Library Dot Product.
e Click the OK button.

To adjust the column order, do the following:
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e C(lick the Total Area column header and drag it to the left edge of the Precursor Replicate Note

column.

Skyline should now look something like:
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You can now review the results for other precursors by doing the following:

e Click in the peptide tree view.
e Use the up and down arrow keys to change the selection to other precursor elements.

Finally expand a precursor and review its transitions. You could apply the same technique to customize
the columns being displayed for transitions. Instead, continue now to the final section in this tutorial to
learn how to add a custom annotation that you can control with the Results Grid, and later exportin a
Skyline report.

Custom Annotations
Skyline supports three types of custom annotations:

1. Free text (similar to the Note which is available by default on all types)
2. True/False
3. Value list
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The last two types can be used to collect information in a controlled vocabulary, as you process your
data, which can later be exported in a Skyline report and used as input for programmatic statistical
analysis.

To define a simple new True/False annotation, perform the following steps:

e  On the Settings menu, click Annotations.

e C(lick the Edit List button on the Annotation Settings form.

e Click the Add button on the Define Annotations form.

e Type ‘Tailing’ in the Name field on the Define Annotation form.
e Select ‘True/False’ in the Type field.

e Check the Precursor Results checkbox in the Applies To list.

The Define Annotation from should now look like:

1ia Define Annotation ﬁ

Name:

Tailing

Type:

( True/False -
Values:

Applies To:
(] Proteins
[ Peptides
(] Precursors
[] Transitions
(9 PrecursorResuts [,

7] Transtion Results |

| Lok J[ Concel |

Now finish defining the annotation and add it to your document by doing the following:

e Click the OK button on the Define Annotation form.
e (Click the OK button on the Define Annotations form.
e Check the checkbox for the new ‘Tailing’ annotation.

The Annotation Settings form should now look like:
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3 S

Annotations are extra pieces of data which you can attach to elements in a Skyline document.
Use this dialog to control which annotations are available in this document, as well as to define
new annotations.

[V] Tailing | Edit List... |

fia Annotation Settings

ok (oo ]

e Click the OK button.

Select the second to last precursor element ‘564.7746++" for the peptide ‘ESDTSYVSLK’. You should see
the new Tailing column added as the last column in the Results Grid. Click on it and drag it to the left
edge of the Precursor Replicate Note column where it can be more easily edited. You can also click and
drag the lines between the column headers to resize the columns for easy viewing and editing.

The Skyline window should now look something like:
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The peaks in this document do not have a lot of issues, but this one does have some peak tailing. Check
the checkbox in the new Tailing column for the ‘Repl’ row. Change selection to each of the other 5
rows. Decide whether you think the tailing is worth noting and check the checkbox, if you think it is.
Change the selected item in the precursor tree and then return to the ‘564.7746++’ precursor to verify
that your changes were recorded.

You can now export the new Tailing annotation in a Skyline custom report. It will appear in the
PrecursorResults field group.

Conclusion

This tutorial has introduced you to the flexible custom reports Skyline offers for accessing the rich set of
values associated with your Skyline targeted proteomics documents. These reports offer a smooth path
from data analysis within Skyline to more complex statistical analysis with Excel or custom programs in
R, Matlab, Java or C++. You have learned about summary statistics available through these report
templates, which can provide quick indicators of data quality. You can share your custom report
templates with collaborators or as supplementary material in your publications, helping others to repeat
your analyses with new data sets even from different instrumentation, taking full advantage of the
Skyline multi-vendor support. Finally, you learned how to use the Skyline Results Grid to gain immediate
access to many of the values available in Skyline reports and to work with custom annotations to add
rich new information to your documents. If you were not aware of these features before, they will
certainly increase the scope of experiment you can achieve with Skyline.
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Glossary of Custom Report Fields

Proteins (top level):

(0]

ProteinName — Protein Name as defined or entered into Skyline (in some cases in
conjunction with the accession number).

ProteinDescription — When proteins are imported into Skyline through public FASTA
sequence files, a Protein Description is provided. You can see the Protein Description
also when you hover over the protein name in the peptide tree view.

ProteinSequence — When proteins are imported into Skyline through public FASTA
sequence files the full protein sequence is accessible. You can see the protein sequence
also when you hover over the protein name in the peptide tree view.

ProteinNote — A free text note associated with the protein by clicking Edit Note on the
Edit menu.

Results (top level):

O ReplicateName — The replicate name assigned to the data during import.

O ReplicatePath — Reserved for future use.

0 FileName — The name of the file from which the data was imported.

0 SampleName — The sample name, if the data was imported from a multi-sample WIFF
file, or the file name again for other file types.

0 ModifiedTime — Last time and date at which the original mass spectrometer file was
modified on disk.

0 AcquiredTime — Last time and date at which the mass spectrometer began acquiring this
replicate data. Or #N/A if the file was imported with a version older than 1.1.

Peptides:

0 PeptideSequence — Amino acid sequence of the peptide

0 BeginPos — The position of the first (N-terminal) amino acid of the peptide within its
containing protein sequence, or #N/A if no protein sequence is available.

0 EndPos — The position of the last (C-terminal) amino acid of the peptide within its
containing protein sequence, or #N/A if no protein sequence is available.

0 PredictedRetentionTime — The retention time predicted by a retention time regression
between a set of measured results and a retention time calculator (currently only
SSRCalc 3.0 is available), or #N/A if no retention time regression has been assigned.

0 AverageMeasuredRetentionTime — The average peptide retention time over all
replicates.

0 PeptideNote — A free text note associated with the peptide by clicking Edit Note on the

Edit menu.

PeptideResults (per replicate values):
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PeptidePeakFoundRatio — The ratio of transitions for which a peak was measured to the
total number of transitions in the peptide. Peak indicators in the peptide tree view
correspond to green = 1.0 (all transitions integrated), orange >= 0.5, red < 0.5.
PeptideRetentionTime — Peptide retention time for each replicate run.
RatioToStandard — Peptide area ratio of light to heavy.

e Precursors:

o
o

Charge/PrecursorCharge — The charge associated with the precursor ion.
IsotopelLabelType — A label type name associated with the precursor ion (light/heavy),
indicating which isotope modifications are applied.

PrecursorNeutralMass — Neutral mass of the precursor in Daltons.

Mz/PrecursorMz —The mass to charge ratio (m/z) of the precursor ion.

CollisionEnergy - Collision Energy for the precursor ion according to instrument/vendor
specific default collision energy equation within Skyline.

DeclusteringPotential - Declustering Potential for the precursor ion according to
instrument/vendor specific default declustering potential equation within Skyline.
ModifiedSequence - Peptide sequence including any amino acid modifications such as
cysteine alkylation. (example: AGLC[+57]QTFVYGGC[+57]R)

PrecursorNote — A free text note associated with a precursor by clicking Edit Note on
the Edit menu.

LibraryName — The name of a MS/MS spectral library, if a MS/MS spectral library
spectrum is associated with the precursor ion.

LibraryType — The type of MS/MS spectral library (BiblioSpec, GPM, NIST), if a MS/MS
spectral library spectrum is associated with the precursor ion.

PrecursorLibraryRank — A MS/MS spectral library ranking of the precursor among other
precursors for a protein that match supplied spectral libraries, using a score specified in
the peptide library settings.

LibraryScorel — Raw peptide library score that may or may not be used to rank among
precursors of a protein.

LibraryScore2 — Raw peptide library score that may or may not be used to rank among
precursors of a protein.

LibraryScore3 — Raw peptide library score that may or may not be used to rank among
precursors of a protein.

e PrecursorResults (per replicate values):

(0]

PrecursorPeakFoundRatio — The ratio of transitions for which a peak was measured to
the total number of transitions in the precursor. Peak indicators in the peptide tree
view correspond to green = 1.0 (all transitions integrated), orange >= 0.5, red < 0.5.
BestRetentionTime — The RetentionTime value of the transition with the highest
maximum intensity for the precursor.

MaxFwhm — The maximum full width at half max (FWHM) of the transitions for the
precursor.
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MinStartTime — Minimum StartTime of all transitions for a precursor. Unless manually
edited all transitions for a precursor use the same integration boundaries.

MaxEndTime — Maximum EndTime of all transitions for a precursor. Unless manually
edited all transitions for a precursor use the same integration boundaries.

TotalArea — The summed Area values of all individual transitions for the particular
precursor.

TotalBackground — The summed Background values of all individual transitions for the
particular precursor.

TotalAreaRatio — The ratio of the TotalArea of this precursor to the first internal
standard label type, before version 0.7 this was always light/heavy, and appeared on the
heavy precursor.

TotalAreaNormalized — The TotalArea normalized to the sum of the TotalArea values
for all peptide precursors in the document.

CountTruncated— The number of transitions for a precursor that integrate a peak with a
boundary at either end of the acquisition time range, where intensity at the end is
greater than 1% of the entire peak height higher than the other extent.
LibraryDotProduct — The dot-product (described in the original BiblioSpec article
http://www.ncbi.nlm.nih.gov/pubmed/18428681) between the individual transition
peak areas of the precursor and the intensities of the matching ion peaks in the

matched MS/MS spectral library spectrum, or #N/A if the precursor has not matching
library spectrum or has fewer than 4 transitions. This is a useful value for method
refinement. It works best when 6 or more transitions are present.

UserSetTotal — True if the default choice of peak or its boundaries was manually altered.
OptStep — Optimization step value indicating distance from the default value for the
parameter being optimized, 0 for the default parameter value, or if no optimization is
being performed in the replicate.

OptCollisionEnergy — The collision energy value corresponding to the OptStep if
collision energy optimization is being performed.

OptDeclusteringPotential — The dlecustering potential value corresponding to the
OptStep if declustering potential optimization is being performed.
PrecursorReplicateNote — A free text note associated with a result set of the precursor
using the Results Grid.

e PrecursorResultsSummary (summary statistics across all replicates):

o
o
o

MinBestRetentionTime — Minimum of the precursor BestRetentionTime values.
MaxBestRetentionTime — Maximum of the precursor BestRetentionTime values.
RangeBestRetentionTime — The difference between MaxBestRetentionTime and
MinBestRetentionTime, which can be used to gauge the spread of retention times
measured.

MeanBestRetentionTime — Mean of the precursor BestRetentionTime values.
StdevBestRetentionTime — Standard deviation of the precursor BestRetentionTime
values.
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O O OO0 OO0 oo

CvBestRetentionTime — Coefficient of variation (CV) of the precursor
BestRetentionTime values.

MeanMaxFwhm — Mean of the precursor MaxFwhm (peak width) values.
StdevMaxFwhm — Standard deviation of the precursor MaxFwhm (peak width) values.
CvMaxFwhm — Coefficient of variation (CV) of the precursor MaxFwhm (peak width)
values.

MeanTotalArea — Mean of the precursor TotalArea values.

StdevTotalArea — Standard deviation of the precursor TotalArea values.

CvTotalArea — Coefficient of variation (CV) of the precursor TotalArea values.
MeanTotalAreaRatio — Mean of the precursor TotalAreaRatio values.
StdevTotalAreaRatio — Standard deviation of the precursor TotalAreaRatio values.
CvTotalAreaRatio — Coefficient of variation (CV) of the precursor TotalAreaRatio values.
MeanTotalAreaNormalized — Mean of the precursor TotalAreaNormalized values.
StdevTotalAreaNormalized — Standard deviation of the precursor TotalAreaNormalized
values.

CvTotalAreaNormalized — Coefficient of variation (CV) of the precursor
TotalAreaNormalized values.

e Transitions:

(0]

O O O O O

ProductCharge — Charge (z) of the product ion.

ProductNeutralMass - Neutral mass of the product ion peptide fragment in Daltons.
ProductMz — The mass to charge ratio (m/z) of the product ion.

Fragmentlon — The name of the product ion peptide fragment (e.g. y8, y10, b7, etc.).
FragmentlonType — The type of the production (y, b, ¢, z, a, x, precursor)
FragmentlonOrdinal — Position of the amino acid in the peptide after (C-terminal of)
which the peptide was cleaved upon fragmentation. (e.g. 8, 10, 7, etc.)

CleavageAa - Specific amino acid residue in the peptide after (C-terminal of) which the
peptide was cleaved upon fragmentation. (e.g. P, M, S, T, etc.)

TransitionNote — A free text note associated with the transition by clicking Edit Note on
the Edit menu.

LibraryRank — Intensity ranking of the MS/MS spectral library fragment ion peak
matching the product m/z for this transition, if a matching spectrum is associated with
the precursor.

Librarylntensity — Raw Intensity value of the MS/MS spectral library fragment ion peak
matching the product m/z for this transition, if a matching spectrum is associated with
the precursor.

e TransitionResults:

o
o
o

RetentionTime — Retention time at the maximum intensity for a transition peak.
Fwhm — Full width at half max (FWHM) for the transition peak.
FwhmDegenerate — True if one of the peak integration boundaries intersects the
chromatogram above the half maximum intensity.
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StartTime — Retention time at the starting integration boundary for the transition peak.
EndTime — Retention time at the ending integration boundary for the transition peak.
Area — Area under the curve (AUC), minus background, for the transition peak.
Background — The area of the rectangle formed by the integration boundaries, and the
baseline and a line perpendicular to minimum intersection intensity between the
integration boundaries and the chromatogram for the transition peak.

AreaRatio — The ratio of the Area of this transition to its corresponding transition in the
first internal standard label type, before version 0.7 this was always light/heavy, and
appeared on the heavy transitions.

AreaNormalized - The Area normalized to the sum of the Area values for all transitions
in the document.

Height — The maximum intensity of the points between the transition peak integration
boundaries.

Truncated- True if the integrated a peak has a boundary at either end of the acquisition
time range, where intensity at the end is greater than 1% of the entire peak height
higher than the other extent. Or #N/A if the data was imported with a version older
than 1.1.

PeakRank — The rank based on Area of this transition among all other transitions of the
same precursor.

UserSetPeak — True if the default choice of peak or its boundaries was manually altered.
TransitionReplicateNote - A free text note associated with a result set of the transition
using the Results Grid.

e TransitionResultsSummary (summary statistics across all replicates):

o
o
o

O O OO OO o o o o o oo

MinRetentionTime — Minimum of the transition RetentionTime values.
MaxRetentionTime — Maximum of the transition RetentionTime values.
RangeRetentionTime — The difference between MaxRetentionTime and
MinRetentionTime, which can be used to gauge the spread of retention times
measured.

MeanRetentionTime — Mean of the transition RetentionTime values.
StdevRetentionTime — Standard deviation of the transition RetentionTime values.
CvRetentionTime — Coefficient of variation (CV) of the transition RetentionTime values.
MeanFwhm - Mean of the transition Fwhm (peak width) values.

StdevFwhm - Standard deviation of the transition Fwhm (peak width) values.
CvFwhm - Coefficient of variation (CV) of the transition Fwhm (peak width) values.
MeanArea - Mean of the transition Area values.

StdevArea- Standard deviation of the transition Area values.

CvArea - Coefficient of variation (CV) of the transition Area values.
MeanAreaRatio - Mean of the transition AreaRatio values.

StdevAreaRatio - Standard deviation of the transition AreaRatio values.
CvAreaRatio - Coefficient of variation (CV) of the transition AreaRatio values.
MeanAreaNormalized - Mean of the transition AreaNormalized values.
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0 StdevAreaNormalized - Standard deviation of the transition AreaNormalized values.
0 CvAreaNormalized - Coefficient of variation (CV) of the transition AreaNormalized
values.
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